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About This Manual

This manual covers the operating and maintenance instructions for the 
following models:

Changes to this Manual

We have made every effort to ensure this manual is accurate. If you discover 
any errors, or if you have suggestions for improving this manual, please send 
your comments to our Solon, Ohio factory. This manual may be periodically 
updated. When inquiring about updates to this manual refer to the part number 
and revision on the title page.

Chapter Layout

Introduction — Describes the features of the VPM3, lists compatible sensors 
and provides installation instructions.
Displays — The VPM3 provides a variety of display types for viewing 
measurement data, the displays are described in this chapter.
Menus — Menus are used in VPM3 for the purpose of sensor configuration 
and viewing measurement data.
Measurement Modes — Most Bird sensors operate in Average Power mode, 
but recent sensors have additional capabilities, this chapter describes the varies 
modes available in VPM3.
Theory of Operation — This chapter provides in depth descriptions of VPM3 
concepts.
Operating Procedures — This chapter provides procedures for operating 
VPM3 with the compatible Bird Sensors, creating presets, making 
measurements, and viewing saved data.
Specifications — Provides the PC requirements for VPM3 installation.

VPM3-MSP
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Chapter 1 Introduction

Virtual Power Meter (VPM) 3 is a powerful tool used to turn a PC into a Power 
Meter. VPM3 is capable of displaying measurements from Bird’s USB 
compatible Power Sensors. Figure 1 on page 2 shows the full line of USB 
compatible sensors.

Note: ONLY sensors that have USB connections or USB Interface 
cable can be used with VPM3 software.

VPM3 sports the following features:

 Three display formats: Digital Display, Analog Display, and Chart 
Display.

 Supports all modes of operation available in Bird Power sensors: Aver-
age Power Mode, Time Domain Mode, Statistical Power Mode

 Displays the full range of capabilities for each sensor, such as: Forward 
Average Power, Reflected Average Power, Match Measurements, 
Forward Peak Power, Forward Burst, Crest Factor, CCDF, Statistical 
Power, Pulse Power, and Gated Average depending upon the 
capabilities of the connected sensor.

 Displays power measurements in Watts or dBm.

 Displays match units in VSWR, Return Loss, Rho, or efficiency %, 
reflected %.

 Log measurement data to a file.

 Playback Logged measurement Data. 

 Save and recall sensor configuration setups.
1
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Figure 1   VPM Compatible Sensors 
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VPM Installation

1. Insert installation CD. 
2. Select Install Software when prompted.

Note: Set-up will inspect the computer for any missing operating 
system prerequisites. If all are present, skip to step 6.

3. Select ‘Next ‘and the install utility begins the Prerequisites Installation 
process.

Figure 2   Install, Prerequisites Installation

4. Review the End-User License Agreement, check “I accept the terms of the 
License Agreement” and select “Install.”

Note: The install Utility will install the prerequisites. This may take 
several minutes

Note: When completed, check with Microsoft® support center for 
any security updates. Typically, if “Automatic Updates” are config-
ured on the host PC, these will be automatically flagged and 
selected for download and installation.

Note: The VPM3 installation utility will launch after the OS pre-
requisites are installed.

5. Do one of the following:
 Accept the default installation location 

 Select a different folder:

6. Select ‘Next’ and the installer will complete.
7. Select “Finish” to launch the VPM3 program:

Note: When the VPM3 loads for the first time, the Preferences 
Dialog will prompt for a default log file save location. Perform the 
following to complete the process.

8. Select the ‘Logging’ tab.
9. Enter a folder local to the PC to store log file data. 
3
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Note: This can be changed at any time in the Preferences. All 
active sensor sessions must be closed before Preferences Dialog 
can be opened.

10. Select the Advanced Tab.
11. Select the language in the drop down menu. 

Note: For any non-US English language setting, select ‘Windows’. 
Any standard formats such as number and date formats from 
“Regional and Language Options” found in the  
Windows Control Panel will be mimicked in the VPM3 interface. 
4



Chapter 2  Displays

Bird Power Sensors offer a variety of measurement capabilities. The modes and 
displays available in VPM3 will depend on the connected sensor. All of the 
display types discussed in this chapter are available in the VPM3 for all sensors. 
Display Types — Measurements may be displayed using the following 
display types:

 Digital Display - Bar

 Analog Display - Meter

 Chart Display - X/Y Graph

Measurement Details — All sensor measurements are displayed in the 
details section just below the measurement display. The details section consist 
of the following tabs

 Measurements Tab

 Statistics Tab

 States Tab
5
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Digital Display

The digital display shows the selected measurement type (Forward Average, 
Reflected Average, Match, etc.) in a numerical format at the top of the main 
power display over a bar graph. Ancillary readings are displayed under the bar 
graph. See Figure 3 and Table 1 on page 6 for a description of the display and 
its features.

Figure 3   Digital Display

Table 1 - Digital Display Description
Item Name Description

1 Menu Bar
Menu bar contains menus for controlling VPM3 
operation, measurement selection, and controlling 
sensor sessions. See “Menu Bar” on page 18.

2 Sensor 
Information

The selected sensor part number information is 
displayed in the window title bar, the sensors serial 
number is displayed in the top status bar. 

3 Logging Status Displays the current status of data logging. See 
“Logging” on page 71.

4 Data Stream 
Status

Displays the current status of the data stream from the 
sensor. See “Data Buffering” on page 68.

5 Control Panel 
Menu Options

The options available for the currently selected Menu 
Tab (7). See “Control Panel Menus and Options” 
on page 36.
6



Displays
6 Display Type 
Selection

Buttons allow the user to quickly select between digital, 
analog, and chart display types. 

7 Control Panel 
Menu Buttons

Menu buttons allow the user access to menus for 
controlling VPM3 operation, the available menus are 
also available on the menu bar (1). See “Control 
Panel Menus and Options” on page 36.

8 Playback 
controls

Playback controls are used to replay buffered data or log 
files. See “Playback” on page 70.

9 Sensor Status Indicates the connection status or zeroing progress of 
the sensor.

10 Sensor Readings

Displays all of the readings returned by the sensor in its 
current configuration. Two tabs are available one for 
measurements and one for measurement statistics. See 
“Measurement Details” on page 16.

11 Bar Graph

The bar graph gives a visual indication of the main 
reading as well as displaying the currently selected 
measurement in numerical format. The scale of the 
graph can be set to auto or full-scale. 

12 Limit Indicators
Limit indicators give visual indication the measured 
signal is less than or greater than user selected limits. 
See "Limit Indicators" on page 67.

Item Name Description
7
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Analog Display

The analog display shows the selected measurement type (Forward Average, 
Reflected Average, Match, etc.) using a traditional meter style format. The 
numerical value of the meter reading is displayed under the meter. Ancillary 
readings are displayed to the left and right of the selected measurement. See 
Figure 4 and Table 2 for a description of the displays features.

Figure 4   Analog Display

Table 2 - Analog Display Description
Item Name Description

1 Menu Bar
Menu bar contains menus for controlling VPM3 
operation, measurement selection, and controlling 
sensor sessions. See “Menu Bar” on page 18.

2 Sensor 
Information

The selected sensor part number information is 
displayed in the window title bar, the sensors serial 
number is displayed in the top status bar. 

3 Logging Status Displays the current status of data logging. See 
“Logging” on page 71.

4 Data Stream 
Status

Displays the current status of the data stream from the 
sensor. See “Data Buffering” on page 68.

5 Control Panel 
Menu Options

The options available for the currently selected Menu 
Tab (7). See “Control Panel Menus and Options” 
on page 36.
8



Displays
6 Display Type 
Selection

Buttons allow the user to quickly select between digital, 
analog, and chart display types.

7 Control Panel 
Menu Buttons

Menu buttons allow the user access to menus for 
controlling VPM3 operation, the available menus are 
also available on the menu bar (1). See “Control 
Panel Menus and Options” on page 36.

8 Playback 
controls

Playback controls are used to replay buffered data or log 
files. See “Playback” on page 70.

9 Sensor Status Indicates the connection status or zeroing progress of 
the sensor.

10 Sensor Readings

Displays all of the readings returned by the sensor in its 
current configuration. Two tabs are available one for 
measurements and one for measurement statistics. See 
“Measurement Details” on page 16.

11 Meter

The meter gives a visual indication of the main reading 
as well as displaying the currently selected 
measurement in numerical format. The scale of the 
meter can be set to auto or full-scale. 

12 Limit Indicators
Limit indicators give visual indication the measured 
signal is less than or greater than user selected limits. 
See "Limit Indicators" on page 67.

Item Name Description
9
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Chart Display

The chart display shows running time trace of sensor data for the selected 
measurement type (Forward Average, Reflected Average, Match, etc.). The 
scale for each axis of the chart can be manually adjusted. Additionally, markers 
can be displayed on the chart to aid in signal analysis. See Figure 5 and Table 3 
for a description of the displays features.

Figure 5   Chart Display

Table 3 Chart Display Explanation
Item Name Description

1 Menu Bar
Menu bar contains menus for controlling VPM3 
operation, measurement selection, and controlling 
sensor sessions. See “Menu Bar” on page 18.

2 Sensor 
Information

The selected sensor Part number information is 
displayed in the window title bar, the sensors serial 
number is displayed in the top status bar. 

3 Logging Status Displays the current status of data logging. See 
“Logging” on page 71.

4 Data Stream 
Status

Displays the current status of the data stream from the 
sensor. See “Data Buffering” on page 68.

5 Control Panel 
Menu Options

The options available for the currently selected Menu 
Tab (7). See “Control Panel Menus and Options” 
on page 36.
10
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6 Display Type 
Selection

Buttons allow the user to quickly select between digital, 
analog, and chart display types.

7 Control Panel 
Menu Buttons

Menu buttons allow user access to menus for controlling 
VPM3 operation, the available menus are also available 
on the menu bar (1). See “Control Panel Menus and 
Options” on page 36.

8 Playback 
controls

Playback controls are used to replay buffered data or log 
files. See “Playback” on page 70.

9 Sensor Status Indicates the connection status or zeroing progress of 
the sensor.

10 Sensor Readings

Displays all of the readings returned by the sensor in its 
current configuration. Two tabs are available one for 
measurements and one for measurement statistics. See 
“Measurement Details” on page 16

11 Marker 
Information

Displays the values on the x and y-axis for the current 
marker position. There is also difference data displayed. 
See “Chart Markers” on page 13.

12 Scroll Buttons
Thew Scroll buttons allow the user to manually scroll 
along the x-axis when the x-axis scale is set to manual. 
See “X-Axis Scrolling” on page 14.

13 Chart

The chart displays the selected sensor reading on a two 
dimension chart. The Y-Axis scale shows the Power of 
the signal over time on the X-Axis. The Y-Axis scale can 
be set to auto or full-scale, using the menu options, or 
the scale can be manually entered by right-clicking on 
the chart’s Y-Axis. 

Item Name Description
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Chart Display Options

Right clicking inside the chart display will provide the following options:
Show Markers — Toggles markers on & off. See “Chart Markers” on 
page 13.
Show Grid — Turns major & minor grid on/off
Best Fit Data — Adjust scales to show entire range of data
Set Lower/Upper Delta Marker — Moves the marker to the location of the 
mouse pointer & automatically sets the position in time for the marker.

Figure 6   Chart Options Menu
12
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Chart Markers

There are two markers that may be displayed for the chart display. Both 
markers are either On or Off. Once displayed the time location and power level 
at each markers location will be displayed below the chart. See Figure 7.
If the data stream is on (or playback is initiated) the markers will move toward 
the left edge of the chart as time on the x-axis is updated.
Display Markers
To display the markers, right click on the chart and select “Show Markers.”
Move Markers
The markers can be moved in three ways:

 Use the mouse cursor, click on the marker and drag the marker to the 
desired location.

 Type a new time into the time display text box for the marker to move 
the marker to an exact time location.

 Right click on the chart at the location in time you wish to move the 
marker and select “Set Lower Delta Marker” or “Set Upper Delta 
Marker.”

Figure 7   Chart Markers
13
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Chart Axis Scaling

The X and Y axis of the chart default to auto scaling, the y-axis is auto scaled to 
the signal power level and the x-axis typically begins at zero and time is added 
to the scale as the data stream is collected.
There are two ways to affect scaling.

 The View Menu option Meter Range, allows the range to be set to Auto 
or Full. When Auto is selected the scale is determined by the signal 
range, when set to Full, the full range of the connected sensor is 
displayed.

 Right clicking on either the Y axis or the X axis will display the appropri-
ate Edit Axis dialog box.

Figure 8   Chart Axis Scaling Dialog Boxes

Manual Y-Axis Scaling
Right click on the y-axis to display the Edit Axis dialog box. Select the Manual 
radio button, and enter a minimum and/or maximum value for the y-axis scale.
Manual X-Axis Scaling
Right click on the y-axis to display the Edit Axis dialog box. Select the Manual 
radio button, and enter a minimum and/or maximum value for the y-axis scale.

X-Axis Scrolling
When the x-axis is set to manual using the Edit Access dialog box, the x-axis 
scrolling option is activated. When enabled the user may select to auto scroll or 
manual scroll the scale. See Figure 9 on page 15.
Auto Scroll — When checked, the chart will automatically advance forward in 
time maintaining the same interval specified in the x-axis manual scale entry.
When Auto Scroll is deselected the scroll buttons are operational and perform 
the following functions:
<<, >> — Moves chart to start, end of log
<, > — Moves chart one span to the left or right 
14
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Figure 9   Chart X-Axis Scrolling
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Measurement Details

All sensor measurements are displayed in the details section just below the 
measurement display. The details section consist of the following tabs:

Measurements Tab

The Measurement Details Tab displays the current measurements from the 
sensor and other calculated fields derived from sensor data. All of the sensors 
current readings are displayed (depending on mode/options). Readings 
displayed in red text are invalid or out of limits data.

Figure 10   Measurements Tab

Statistics Tab

The Statistics Tab displays the main sensor measurements for the current mode 
along with the mean, min, and max for each measurement.
Statistics are automatically reset if a change is made that affects power 
measurement such as adding an input offset.
Statistics can be manually reset by clicking Reset (XXX) in the top left corner of 
the statistics table.

Figure 11   Statistics Tab
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States Tab

7027, 7029, and 7037 Series Sensors
The States Tab displays:

 Values for the Average pulse power measurement of all the enabled 
State Configurations.

 Begin and end time for each state.

 Transition time from one state to the following state. 

 Duty Cycle for each state

See "State Average" on page 55.

Figure 12   States Tab
17



Chapter 3 Menus

Menus within the VPM3 are available in the menu bar and the control panel. 
The Menu Bar consists of menus with drop down options. Most of the options 
available on the menu bar are also available on the control panel. The control 
panel consists of menu selection buttons below the sensor readings and option 
buttons on the right side of the VPM3 window. The options displayed will 
change when menu selection buttons are pressed.

Figure 13   Menu Locations

Menu Bar

The options displayed on the menu bar will vary greatly from one Bird Power 
Sensor to the next. All of the possible options are listed in this chapter, if menus 
or options do not apply for your sensor, those options will not be visible when 
your sensor is connected. 
In this manual, menu items that are specific to one or more power sensors will 
include the sensor model number following the heading (e.g. 7022).
18
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File Menu

Figure 14   File Menu

New Sensor Session
Displays the Select Sensor(s) dialog box (Figure 15). All Bird sensors connected 
to the computer will be listed. Selecting New Sensor Session does not close any 
active sensor window/connection. 
Selecting a sensor from the list and clicking Connect will initiate a new session 
for the selected sensor. See "Preferences" on page 21 for information about 
automatically starting sensor sessions.

Figure 15   Select Sensor(s) Dialog Box

Open
Session — Displays the Select a session file dialog. Session files contain the 
configuration/settings for each Bird Sensor that has been connected to VPM3. 
The Open Session dialog allows the use of a “preset” configuration when 
connecting to a new sensor. See "Open Session File" on page 88.
Measurement — Displays the Log Browser dialog box. The Log Browser lists 
all snapshot and logged measurements contained in the VPM3 Measurements 
folder. See "Open Measurement File" on page 88.
Reference Measurement — Displays the Select a reference measurement 
dialog box. Reference Measurements are only used by the 7022 sensor in the 
statistical mode. See "Statistical Power Measurement" on page 62.
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Close Session
Closes the active session window. If more than one sensor session is open only 
the active session will close.
Save Session As...
Saves the current session under a different name. This allows the user to save a 
“preset” configuration for use when connecting to a new sensor or for recall as 
desired.
Save Measurement Snapshot
During data acquisition, saves the most recent measurement frame to a file 
without displaying the measurement file save dialog. 
During playback, saves the currently displayed measurement frame to a file 
without displaying the measurement file save dialog.
Snapshots are saved in XML format. See “Snapshots” on page 69 for additional 
information.
Save Measurement Snapshot As...
Displays the Save Snapshot dialog box. Allows the use of a unique filename 
when saving a measurement snapshot to file. See “Snapshots” on page 69 for 
additional information.
Recent Sessions
Displays a list of recent session files, a sensor must be connected to open a 
recent session. Only sensor session created by the same type of sensor may be 
opened.
A Clear List option allows the recent session list to be deleted. This option does 
not delete any files. A new list will be started when the next sensor is 
connected.
Recent Measurements
Displays a list of recent measurement log files, a sensor is not required to 
display a saved measurement. Once a saved measurement is open the playback 
controls can be used to view the content of the log file.
A Clear List option allows the recent measurement list to be deleted. This option 
does not delete any files. A new list will be started when the next measurement 
is saved.
20
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Preferences
Displays the Preferences dialog box. All session must be closed to open 
preferences. 
The preferences dialog box has three tabs for options: General, File Locations, 
and Advanced.

Figure 16   Preferences, General Tab

General Tab
Full screen mode — When selected, VPM3 will start in full screen mode. Full 

screen mode can also be toggled on or off using the "View Menu" on page 
34.

Automatically connect to sensors — When selected, the VPM3 will con-
nect to sensors when the program is launched. If more than one sensor is 
connected to the computer, a session will be opened for each sensor.

List sensors on startup — When selected, the VPM3 will display the Select 
Sensor(s) dialog box (Figure 15) at startup. All Bird sensors connected to 
the computer will be listed.

Language — VPM3 supports English and Chinese languages. English is the 
Default language selection. Click the drop-down menu to select option.

Note: Any language change requires VPM3 restart.

Clear Message Box State — When pressed, all previously disabled informa-
tion dialog boxes will be enabled. 

Information dialog boxes are displayed in some circumstances to provide 
additional information to the user, in some dialogs there is a check box 
“Don’t show this again” option to disable the dialog in the future. The 
“Clear Message Box State” resets all the disabled dialog boxes so they will 
be displayed when appropriate.
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Restore Default Settings — When Pressed restores the General Tab set-
tings to factory defaults for one of the following options:

 Desktop computers

 Bird 4422 Power Meter.

Figure 17   Preferences, File Locations

File Locations
Session Directory — Sets the location of the session directory. All Session 

files will be saved to the selected location. See “Sessions” on page 65 for 
additional information about Session Files.

Preset Directory — Sets the location of the preset directory. Preset Files are 
legacy VPM3 files. See “Convert Legacy Preset File to Default Session 
File” on page 89 for information on converting Presets to Session Files.

Measurement Data Directory — Sets the location of the data directory. See 
“Logging” on page 71 for additional information regarding measurement 
files.
22
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Figure 18   Preferences, Advanced Tab

Advanced
Chart History (points) — Sets the number of points to be collected in a ses-

sion. See “Data Buffering” on page 68.

Playback History (frames) — Sets the number of frames created during a 
session. See “Data Buffering” on page 68.

Exit
Closes the program and all open sessions.

Mode Menu

7022, 7023, 7027, 7029, and 7037
The Mode Menu is only displayed if the sensor supports more than one 
measurement mode. 

Note: The 7022 Statistical Power Sensor is currently the only sen-
sor supporting multiple modes.

A check mark indicates the current mode. When another mode is selected the 
check mark will move to the new mode.

Figure 19   Mode Menu

Statistical
7022
When selected, switches Sensor to Statistical Power Mode. See “Statistical 
Power Mode” on page 62.
23



VPM3-MSP Operation Manual
Time Domain
7022, 7027, 7029, and 7037
When selected, switches Sensor to Time Domain Mode. See “Time Domain 
Mode” on page 60.
Average Power
7022, 7023, 7027, 7029, and 7037
When selected, switches Sensor to Average Power mode. See “Average Power 
Mode” on page 50.

Configure

Note: This menu will change depending on the sensor and/or 
mode being displayed. 

Input Offset
Input Offset is used to enter the total value of all couplers and attenuators 
connected to the sensor (for example, the coupling factor of a directional 
coupler).
To read the true power when using a coupler or attenuator, VPM must 
compensate for them. Click Input Offset and enter (in dB) the total attenuation 
or coupling factor. 
To convert percentages to dB, use the equation: 

Note: The Bird 5015-EF uses frequency-dependent correction fac-
tors to provide more accurate measurements that are entered 
here. For more information, refer to the owners manual for the 
5015-EF.

Filter
5012, 5016, 5017, 5018, 5019
Selects the bandwidth for the video filter.

 Full (No Filter, Full bandwidth, 20 MHz)

 400 kHz

 4.5 kHz

Attenuation dB  10 Log10 Attenuation percent  100 =
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Duty Cycle
5012, 5016, 5017, 5018, 5019, 7022
Sets the duty cycle of a measurement. If sensor is capable, the duty cycle will be 
inferred by the sensor hardware and reported. A user-defined duty cycle can be 
entered to override the sensor provided value.

Note: If zero is entered, the duty cycle automatically sets to Auto.

Note: For best duty cycle measurement with the 7022, have at 
least 10 pulses on the time domain screen.

 Auto (Sensor determines the duty cycle of the measurement.)

 Specify Duty Cycle (Manually enter the duty cycle. The specified duty 
cycle will be used to determine the Burst Average power.) 

Note: Use Specify Duty Cycle for best accuracy when the duty 
cycle is known.

CCDF Limit
5012, 5016, 5017, 5018, 5019
Sets the threshold, in Watts, for the CCDF measurement. The Sensor samples 
power over a 300 ms window and compares it to CCDF Limit. The time above 
the threshold relative to the total time is the CCDF.
Elements
5014
Selects the type of element being used in the 5014 Power Sensor. 

 DPM

 43

Forward Scale
5014
Selects wattage of the forward element being used in the 5014 Power Sensor. A 
list of common values is displayed, the value may be clicked to select, or click 
“Other...” to manually enter the element’s value.
Reflected Scale
5014
Selects wattage of the reflected element being used in the 5014 Power Sensor. 
A list of common values is displayed, the value may be clicked to select, or click 
“Other...” to manually enter the element’s value. This option is disabled if F/R 
Scale 10:1 Ratio is selected.
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F/R Scale 10:1 Ratio
5014
Selects the value for the reflected element automatically based on the value 
entered for the forward element. The value for the reflected element will be set 
to 1/10th of the forward element.
Scale
7022
Selects the value for x or y-axis in the statistical and time domain modes.
For Statistical Measurements:

 Upper Range (Specifies the upper limit of the x-axis in dB)
For Time Domain Measurements:

 Time (Specifies the time per division (in seconds) of the x-axis)

 Power (Specifies the power per division (in watts) of the y-axis)

 Reference Level (Specifies the base line reference level for power)

Bandwidth
7022
Selects the bandwidth for the video filter.

 No Filter (full bandwidth, 20 MHz)

 4.5 kHz

 500 kHz

 5 MHz

Run Mode
7022 Statistical Mode
During Statistical Measurements, Selects whether a single measurement is 
acquired, or measurements will automatically be repeated.

 Normal (single measurement)

 Clear Restart (measurements are automatically repeated)
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Avg Smoothing
7022 Average Power Mode
Selects smoothing that is performed by the sensor for average forward.

Note: Avg Smoothing is performed in the sensor itself. It only 
effects the average power measurement in the forward direction 
and is used for very low rep rate signals (<200Hz).

 None (No smoothing is performed.)

 Low (Uses a moving average of 8 samples.)

 Medium (Uses a moving average of 16 samples.)

 High (Uses a modified moving average (exponential average with alpha 
= 1/N).)

Freq. Setpoint
7022, 7023, 7027, 7029, and 7037

 Auto (Sensor determines the frequency of the measurement)

 Specify Frequency Setpoint (Manually enter the frequency of the 
signal. The specified frequency will be used in correcting the power 
measurement.) 

Note: Use Specify Frequency Setpoint when the sensor is unable 
to measure the frequency of a signal.

Confidence Factor
7022
Sets the duration of the statistical measurement using one of the following 
options:

 Percentage (Acquires sufficient samples to achieve an error tolerance 
of +/-0.1% with the specified confidence factor.
Confidence percentage is a user selectable percentage: 80, 90, 95, 99, 
99.9, or 99.99%.)

 Number of Samples (User entered value within a specified range 
between 1144900 and 288354000.)

 Time Duration (User entered value within a specified range between 
26.1 ms and 6.5535 seconds.)
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Max Period
7027, 7029, and 7037

 Auto (Sensor determines the span (pulse period) for the time domain 
display, this may include multiple state changes).

 Specify Max Period (Manually enter the span (pulse period) for the 
time domain display, this may include multiple state changes) 

Note: Use Specify Max Period when the sensor is unable to deter-
mine the span.

State Configure Menu

7027, 7029, and 7037
This menu is used to configure the up to four pulse states when the State 
Average Measurement is selected using a Pulse Sensor.
State Select
Selects the pulse state to be configured. State 1 through 4.
State Enable
Alternate action button, used to enable or disable the selected state.
State Begin
Used to specify a measurement begin time for the selected state. 
State End
Used to specify a measurement end time for the selected state.

Note: The begin and end times are relative to a synchronization 
reference point plus or minus an optional delay. See "State Aver-
age" on page 55 for a detailed explanation.

Analysis Mode
Alternate action button, used set the Analysis Mode in Auto or Manual. See 
"Analysis Mode" on page 56.
Analysis Settings
Used to set the values for pulse state detection when Analysis Mode is set to 
Auto. See "Analysis Mode" on page 56.

 Specify state begin margin...(Specify the beginning margin for 
placement of the begin delay for each pulse, default is 10%). 

 Specify state end margin...(Specify the ending margin for placement of 
the end delay for each pulse, default is 2%).
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 Specify state upper reference...(Upper reference value is one of the 
reference points used to calculate transition time between states). 

 Specify state lower reference...(Lower reference value is one of the 
reference points used to calculate transition time between states). 

 Specify state sensitivity... (specifies a smoothing value to apply to pulse 
measurement data.)

Measurement Menu

Type
Selects the type of measurement for the source of the data to be displayed on 
the analog, digital, or chart display.

 Forward Average

 Reflected Average

 Match

5012, 5016, 5017, 5018, 5019

 Forward Peak

 Forward Burst

 Crest Factor

 CCDF

7023

 Gated Average

7027, 7029, and 7037

 State Average

Amplitude

Max Hold
Holds and displays the highest trace data points.

Zero
5012, 5016, 5015, 5017, 5018, 5019, 7020, 7022
Performs a zero calibration on the selected sensor. See “Zeroing a Sensor” on 
page 97.
Start Acquisition
Starts the Data Stream for the selected Session/Sensor.
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Stop Acquisition
Stops the Data Stream for the selected Session/Sensor. The previously received 
data is retained until Start Acquisition is pressed or the session is ended.
Units
Power — Selects the unit of measure for the power level of the displayed 
signal.

 Watts 

 dBm

Match — Selects the unit of measure for the match measurement displayed 
signal.

 VSWR

 Return Loss dB

 Rho

 Efficiency %

 Reflected %

Note: TPMs (5015) do not have match measurement as an 
option, this menu is not available.

Limits
5012, 5014, 5015, 5016, 5015, 5017, 5018, 5019, 7020
Displays the Limits Dialog Box. Allows users to enter, enable, disable, or delete 
limits for any measurement. See “Limit Indicators” on page 67.
Show/Hide Reference
7022 Statistical Mode
Toggles the display of a reference measurement on and off.
Enable Pulse Measurement
7022 Time Domain Mode
Enables the measurement of pulse characteristics such as duty cycle, overshoot, 
pulse width, rise time, fall time, off time, edge delay, pulse period, and 
repetition rate.
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Trigger Menu

7022 Time Domain Mode
Source 

 Internal (Triggers are internally generated when the signal crosses the 
specified trigger level.)

 External (Triggers are controlled by an external source, input via the 
BNC connector on the 7022 Power Sensor.)

 Manual (Triggers are generated using the Manual Trigger menu 
option.)

Mode
The mode affects operation only when the selected source is Internal or 
External.

 Single (When triggered, one sweep is generated, the sweep will be 
displayed until another sweep is triggered.)

 Auto (The measurement is triggered automatically if the specified 
trigger event does not occur within the greater of 10ms or the 
acquisition interval of the last measurement. 

 Normal (The measurement is not triggered until the specified trigger 
event occurs.)

Edge
When the selected source is Internal, this selects the direction that the signal 
crosses the specified trigger level to cause a trigger event.

 Rising (A sweep is triggered if the input goes from “Low” to “High”.)

 Falling (A sweep is triggered if the input goes from “High” to “Low”.)

Level…

 Auto (Sets the trigger level automatically half way between the max 
and min values of the previous time domain data set.)

 Specify Trigger Level (User entered, sets a specific the trigger power 
level when the trigger source is internal.)
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Delay…
Length of wait after the trigger signal and before beginning a sweep. The range 
is -3600 to 3600 seconds.
0 - the trigger event occurs at the mid-point of the time axis.
Positive values - Trigger event shifts to the left on the display.
Negative values - Trigger event shifts to the right on the display.
Holdoff…
Specifies the minimum amount of time from the end of one measurement to 
the next trigger event.
Manual Trigger
Triggers a single measurement sweep.
Zero Delay
Resets any Trigger delay to zero.
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Log Menu

Logging is a function within VPM3 that records sensor data to a file for 
preservation and analysis. Logs files are stored in the location specified in “File 
Locations” on page 22.
For additional information about logging see “Logging” on page 71.
Enable Data Logging
Used to toggle the logging function on or off. A check mark on the menu option 
indicates Logging is on, additionally “Logging On” is displayed at the top of the 
VPM3 measurement screen.
Restart Session
Clears the current session buffer and restarts the measurements.
Settings
Opens the Logging Settings dialog box. The Logging Settings dialog box is used to 
configure the logging parameters and select the log file type. See “Logging” on 
page 71 for detailed information on logging.

Figure 20   Logging Settings Dialog Box
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View Menu

Fullscreen Mode
Toggles on and off full screen mode for the VPM3 display.
Control Panel
Toggles on and off the display of the control panel menus and options.
Playback Controls
Toggles on and off the display of the playback controls.
Details
Toggles on and off the display of the measurements and Statistics in the Sensor 
Readings area.
Display Style
Selects the display type used to graphically display measurement information. 
See “Displays” on page 5.

 Digital

 Analog

 Chart

Meter Range
Used to control the measurement range displayed for each Display Type. The 
Chart display includes additional controls for the range of the x and y axis. See 
“Chart Display” on page 10.

 Auto (Displayed range is controlled by the measurement value to 
provide increased granularity.)

 Full (Displayed range is the full range capability of the sensor)

Smoothing
Smoothing is performed by VPM3 software after receiving the power readings 
from the sensor. 

 Enabled (Toggles on and off smoothing.) 

 Specify Number of Readings (used to set the number of reading used 
for smoothing the display signal measurement.)
34



Menus
Playback
Playback is used to replay measurements. Playback can be used to playback 
measurements saved in the Frame buffer or for measurements saved in Log 
files. See “Viewing Data Using VPM3 Playback” on page 92 for detailed 
information about playback.

 Clear Buffer (Clears the Frame Buffer)

 No Delay (selects playback with no delay between frames)

 1 sec (selects playback with a one second delay between frames)

 2 sec (selects playback with a two second delay between frames)

 4 sec (selects playback with a four second delay between frames)

 8 sec (selects playback with a eight second delay between frames)

Measurements
402X Series Sensors

 Show/Hide Frequency (toggles on and off the display of the measured 
RF frequency in the Measurement results area.

Window Menu

Cascade Sessions
Organizes the sessions in a cascading, offset display.
Tile Sessions Horizontally
Organizes the sessions horizontally.
Tile Sessions Vertically
Organizes the sessions vertically.
List of Open Sessions
The Windows menu contains a sequential list of active sensor sessions.

Help Menu

User Manual
Opens a PDF of the VPM3 operation manual.
About Virtual Power Meter
Displays version info about the VPM.
About Sensor
Displays model information of the selected sensor.
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Control Panel Menus and Options

Many of the menu bar menus and options associated with making 
measurements are repeated on the control panel. 
The options displayed on the control panel will vary greatly from one Bird Power 
Sensor to the next. All of the possible options are listed in this chapter, if menus 
or options do not apply for your sensor, those options will not be visible when 
your sensor is connected. Any menu item that is specific to one or more power 
sensors will include the sensor model number following the heading (e.g. 7022).

Figure 21   Control Panel Menus

Control Panel menu options are displayed on the right side of the VPM3 screen. 
There are a variety of option selection buttons employed. Many of the option 
buttons are ON/OFF switches or Selection buttons, others have data entry on 
the option or when click open a dialog for data entry. See Figure 22 for 
examples.

Figure 22   Menu Option Buttons
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Configure Button

Note: This menu will change depending on the sensor and/or 
mode being displayed. 

Input Offset
Input Offset is used to enter the total value of all couplers and attenuators 
connected to the sensor (for example, the coupling factor of a directional 
coupler).
To read the true power when using a coupler or attenuator, VPM must 
compensate for them. Click Input Offset and enter (in dB) the total attenuation 
or coupling factor. 
To convert percentages to dB, use the equation: 

Note: The Bird 5015-EF uses frequency-dependent correction fac-
tors to provide more accurate measurements that are entered 
here. For more information, refer to the owners manual for the 
5015-EF.

Filter
5012, 5016, 5017, 5018, 5019
Selects the bandwidth for the video filter.

 Full (No Filter, Full bandwidth, 20 MHz)

 400 kHz

 4.5 kHz

Duty Cycle
5012, 5016, 5017, 5018, 5019, 7022
Sets the duty cycle of a measurement. If sensor is capable, the duty cycle will be 
inferred by the sensor hardware and reported. A user-defined duty cycle can be 
entered to override the sensor provided value.

Note: If zero is entered, the duty cycle automatically sets to Auto.

Note: For best duty cycle measurement with the 7022, have at 
least 10 pulses on the time domain screen.

 Auto (Sensor determines the duty cycle of the measurement.)

 Specify Duty Cycle (Manually enter the duty cycle. The specified will be 
used to determine the Burst Average power.) 

Note: Use Specify Duty Cycle for best accuracy when the duty 
cycle is known.

Attenuation dB  10 Log10 Attenuation percent  100 =
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Meter Range
Used to control the measurement range displayed for each Display Type. The 
Chart display includes additional controls for the range of the x and y axis. See 
“Chart Display” on page 10.

 Auto (Displayed range is controlled by the measurement value to 
provide increased granularity.)

 Full (Displayed range is the full range capability of the sensor)

CCDF Limit
5012, 5016, 5017, 5018, 5019
Sets the threshold, in Watts, for the CCDF measurement. The Sensor samples 
power over a 300 ms window and compares it to CCDF Limit. The time above 
the threshold relative to the total time is the CCDF.
Elements
5014
Selects the type of element being used in the 5014 Power Sensor. 

 DPM
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Forward Scale
5014
Selects wattage of the forward element being used in the 5014 Power Sensor. A 
list of common values is displayed, the value may be clicked to select, or click 
“Other...” to manually enter the element’s value.

Reflected Scale
5014
Selects wattage of the reflected element being used in the 5014 Power Sensor. 
A list of common values is displayed, the value may be clicked to select, or click 
“Other...” to manually enter the element’s value. This option is disabled if F/R 
Scale 10:1 Ratio is selected.
F/R Scale 10:1 Ratio
5014
Selects the value for the reflected element automatically based on the value 
entered for the forward element. The value for the reflected element will be set 
to 1/10th of the forward element.
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Bandwidth
7022
Selects the bandwidth for the video filter.

 No Filter (full bandwidth, 20 MHz)

 4.5 kHz

 500 kHz

 5 MHz

Run Mode
7022 Statistical Mode
During Statistical Measurements, Selects whether a single measurement is 
acquired, or measurements will automatically be repeated.

 Normal (single measurement)

 Clear Restart (measurements are automatically repeated)

Avg Smoothing
7022 Average Power Mode
Selects smoothing that is performed by the sensor for average forward.

Note: Avg Smoothing is performed in the sensor itself. It only 
effects the average power measurement in the forward direction 
and is used for very low rep rate signals (<200Hz).

 None (No smoothing is performed.)

 Low (Uses a moving average of 8 samples.)

 Medium (Uses a moving average of 16 samples.)

 High (Uses a modified moving average (exponential average with alpha 
= 1/N).)

Freq. Setpoint
7022, 7023 

 Auto (Sensor determines the frequency of the measurement)

 Specify Frequency Setpoint (Manually enter the frequency of the 
signal. The specified frequency will be used in correcting the power 
measurement.) 

Note: Use Specify Frequency Setpoint when the sensor is unable 
to measure the frequency of a signal.
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Confidence Factor
7022 Statistical Mode
Sets the duration of the statistical measurement using one of the following 
options:

 Percentage (Acquires sufficient samples to achieve an error tolerance 
of +/-0.1% with the specified confidence factor.
Confidence percentage is a user selectable percentage: 80, 90, 95, 99, 
99.9, or 99.99%.)

 Number of Samples (User entered value within a specified range 
between 1144900 and 288354000.)

 Time Duration (User entered value within a specified range between 
26.1 ms and 6.5535 seconds.)

Average Count
7023 
Specifies the weighting factor used in the formula below to calculate an 
exponential moving average of the pulse related measurement values. See 
“Gated Average” on page 54 for additional details about the average count.

AVGn
1
k
---X n

k 1–
k

-----------AVGn 1–+=

The average count selected is substituted for k in the following equation:

Pulse Gate Times
7023 
Pulse gate times allows user to specify the measurement interval by selecting 
the delay after the pulse rising edge and the interval before the pulse falling 
edge. See “Gated Average” on page 54.

 Pulse Begin Gate Time

 Pulse End Gate Time
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Max Period
7027, 7029, and 7037

 Auto (Sensor determines the span (pulse period) for the time domain 
display, this may include multiple state changes).

 Specify Max Period (Manually enter the span (pulse period) for the 
time domain display, this may include multiple state changes) 

Note: Use Specify Max Period when the sensor is unable to deter-
mine the span.

Note: Specifying the Max Period will reduce the time for the initial 
measurement or when the pulse period changes

State Configure Button

7027, 7029, and 7037
This menu is used to configure the up to four pulse states when the State 
Average Measurement is selected using a Pulse Sensor.
State Select
Selects the pulse state to be configured. State 1 through 4, when Analysis Mode 
is set to manual.
State Enable
Alternate action button, used to enable or disable the selected state, when 
Analysis Mode is set to manual.
State Begin
Used to specify a measurement begin time for the selected state, when Analysis 
Mode is set to manual.
State End
Used to specify a measurement end time for the selected state, when Analysis 
Mode is set to manual.

Note: The begin and end times are relative to a synchronization 
reference point plus or minus a optional delay. See "State Aver-
age" on page 55 for a detailed explanation.

Analysis Mode 
(default = auto)

 Auto (the VPM3 automatically configures begin and end delay times 
for up to four states in a pulse period (frame) based on Analysis 
Setting, see "Analysis Settings" on page 28.

 Manual (the operator provides the state configuration).
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Analysis Settings
Used to specify reference points for measurement periods and transition times 
when Analysis Mode is set to Auto. See "Analysis Mode" on page 56 for a 
detailed explanation.

 Specify state begin margin... (Specifies the percentage of a states width 
to begin average power measurement.) 

 Specify state end margin... (Specifies the percentage of a states width 
to end average power measurement.) 

 Specify state upper reference... (Specifies the upper percentage of a 
transition between states for transition time measurement.) 

 Specify state lower reference... (Specifies the lower percentage of a 
transition between states for transition time measurement.)

 Specify state sensitivity... (specifies a smoothing value to apply to pulse 
measurement data.)

Measurement Button

Note: Specific measurement types depend upon the power sensor 
being used.

Stop/Start
Toggles the Sensor Data Stream on and off for the selected Session/Sensor. 
When stopped the previously received data is retained until Stop/Start is 
pressed again or the session is ended.
Zero
7022
Performs a zero calibration on the selected sensor. See “Zeroing a Sensor” on 
page 97.
For other sensors Zero calibration is on the “Amplitude Button” on page 46.
Max Hold
7022, 7023
Holds and displays the highest trace data points.
For other sensors Max Hold is on the “Amplitude Button” on page 46.
Type:
Selects the type of measurement for the source of the data to be displayed on 
the analog, digital, or chart display.

Forward Average
 See “Forward and Reflected Power” on page 50.
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Reflected Average
 See “Forward and Reflected Power” on page 50.

Match
 See “Match” on page 51.

Forward Peak
5012, 5016, 5017, 5018, 5019

 See “Forward Peak Power” on page 51.

Forward Burst
5012, 5016, 5017, 5018, 5019

 See “Burst Average Power” on page 52.

Crest Factor
5012, 5016, 5017, 5018, 5019

 See “Crest Factor” on page 53.

CCDF
5012, 5016, 5017, 5018, 5019

 See “Complementary Cumulative Distribution Function (CCDF)” on 
page 53.

Gated Average
7023

 See “Gated Average” on page 54.

State Average
7027, 7029, and 7037

 State Average measures the average power of up to four states (signal 
Level) within a pulse period. See"State Average" on page 55.

Show/Hide Reference
7022 Statistical Mode
Toggles the display of a reference measurement on and off.
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Pulse Meas. 
7022 Time Domain Mode
Toggles on and off the measurement of pulse characteristics such as duty cycle, 
overshoot, pulse width, rise time, fall time, off time, edge delay, pulse period, 
and repetition rate.

Trigger Button

7022 Time Domain Mode
Source 

 Internal (Triggers are internally generated when the signal crosses the 
specified trigger level.)

 External (Triggers are controlled by an external source, input via the 
BNC connector on the 7022 Power Sensor.)

 Manual (Triggers are generated using the Manual Trigger menu 
option.)

Mode
The mode affects operation only when the selected source is Internal or 
External.

 Single (When triggered, one sweep is generated, the sweep will be 
displayed until another sweep is triggered.)

 Auto (The measurement is triggered automatically if the specified 
trigger event does not occur within the greater of 10ms or the 
acquisition interval of the last measurement. 

 Normal (The measurement is not triggered until the specified trigger 
event occurs.)

Edge
When the selected source is Internal, this selects the direction that the signal 
crosses the specified trigger level to cause a trigger event.

 Rising (A sweep is triggered if the input goes from “Low” to “High”.)

 Falling (A sweep is triggered if the input goes from “High” to “Low”.)

Level…

 Auto (Sets the trigger level automatically half way between the max 
and min values of the previous time domain data set.)

 Specify Trigger Level (User entered, sets a specific the trigger power 
level when the trigger source is internal.)
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Delay…
Length of wait after the trigger signal and before beginning a sweep. The range 
is -3600 to 3600 seconds.
0 - the trigger event occurs at the mid-point of the time axis.
Positive values - Trigger event shifts to the left on the display.
Negative values - Trigger event shifts to the right on the display.
Zero Delay
Resets any Trigger delay to zero.
Holdoff…
Specifies the minimum amount of time from the end of one measurement to 
the next trigger event.
Manual Trigger
Triggers a single measurement sweep.

Sync Button

7027, 7029, and 7037
Source 

 Internal (Sync event is internally generated when the signal crosses the 
specified Sync level, generated on the rising edge of the pulse.)

 External (Sync Pulse is generated by an external source, input via the 
BNC connector on the Pulse Sensor (TTL level pulse, see Pulse Sensor 
user manual).)

Edge
When the selected source is internal, this selects the direction that the signal 
crosses the specified Sync level to cause a sync event.

 Rising (The sync event occurs when the signal crosses the sync level on 
a transition from “Low” to “High”.)

 Falling (The sync event occurs when the signal crosses the sync level on 
a transition from “High” to “Low”.)

Level…

 Auto (Sets the sync level automatically half way between the max and 
min values of the previous time domain data set.)

 Specify Trigger Level (User entered, sets a specific power level when 
the sync source is internal.)
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Delay…
Length of wait after the trigger signal and before beginning a sweep. The range 
is -0.1 to +0.1 seconds. Default = 0
Specifies a time offset between the Sync Event and the Sync Reference Point. 
A positive value offsets the Reference point to occur after the Event. 
A negative value offsets the Reference point to occur before the Event. 
State timing is specified relative to the Sync Reference Point. See Figure 28 on 
page 55.

Units Button

Power:
Selects the unit of measure for the power level of the displayed signal.

Watts 

dBm
Match:
Selects the unit of measure for the match measurement displayed signal.

VSWR

Return Loss dB

Rho

Efficiency %

Reflected %
Note: TPS (5015) does not have match measurement as an 
option, this menu is not available.

Amplitude Button

Zero
5012, 5016, 5015, 5017, 5018, 5019
Performs a zero calibration on the selected sensor. See “Zeroing a Sensor” on 
page 97.

Note: For 7022 sensor Zero calibration is on the “Measurement 
Button” on page 42.
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Smoothing
Smoothing is performed by VPM3 software after receiving the power readings 
from the sensor. 

 Enabled (Toggles on and off smoothing.) 

 Specify Number of Readings (used to set the number of reading used 
for smoothing the display signal measurement.)

Max Hold
5012, 5014, 5016, 5015, 5017, 5018, 5019
Holds and displays the highest trace data points.

Note: For 7022, 7023 sensors Max Hold is on the “Measurement 
Button” on page 42.

Scale Button

7022
Upper Range 
7022 Statistical Mode
Specifies the upper limit of the x-axis in dB.
Time 
7022 Time Domain Mode
Specifies the time per division (in seconds) of the x-axis.
Power
7022 Time Domain Mode
Specifies the power per division (in watts) of the y-axis.
Reference Level
7022 Time Domain Mode
Specifies the base line reference level for power.

Scale Button

7027, 7029, and 7037
Time 
Pulse Sensor Time Domain Mode
Specifies the time per division of the x-axis.
Default = 10 ms, if Time is changed to a value larger than the current sweep 
time, the sweep time will increase to match.
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Offset
Pulse Sensor Time Domain Mode
Specifies an offset for the x-axis, negative values will shift the displayed signal to 
the right, positive values will shift the displayed signal to the left.
Default = 0, changes to this setting may effect Sweep Delay if new setting is less 
than current Sweep Delay.
Power
Pulse Sensor Time Domain Mode
Specifies the power per division (in watts) of the y-axis.
Reference Level
Pulse Sensor Time Domain Mode
Specifies the base line reference level for power on the y-axis.
Sweep Time
Pulse Sensor Time Domain Mode
Specifies the full range of the x-axis in either number of frames or time. Changes 
to this value can change the value of the time setting (time per division).
Sweep time default setting is “Number of Frames” in this mode the sweep time 
is determined by the Pulse Sensor sensor. Optionally the user may manually set 
the sweep time.

 Number of Frames (the Pulse Sensor sensor counts frames (pulse 
period) based on the sync to determine sweep time, default number = 
1 frame)

 Sweep Time (fixed time period specified by the operator, default = 200 
us)

Sweep Delay
Pulse Sensor Time Domain Mode
Specifies a delay of the displayed sweep information. This delay may be a 
positive or negative entry. A positive entry will shift the visible portion of the 
displayed signal to the left. A negative entry will shift the visible portion of the 
displayed signal to the right.
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File Button

Note: Save and Save As captures the most recent measurement 
readings. It will not store the time-chart information. To store time 
chart display, ensure logging is enabled. See "Logging" on page 
71.

Save 
During data acquisition, saves the most recent measurement frame to a file 
without displaying the measurement file save dialog. 
During playback, saves the currently displayed measurement frame to a file 
without displaying the measurement file save dialog.
Snapshots are saved in XML format. Each quick save is stored in a separate file 
that is named using the date-time file naming format:

Save As
Same as Save, only the Save Snapshot dialog box is displayed. Allows the use of 
a unique filename when saving a measurement snapshot to file.
Capture
Pulse Sensor Time Domain Mode
Captures the data used to display the measurement information currently 
displayed on the Time Domain Graph Display without displaying the 
measurement file save dialog.
Captures are saved in CSV format. Each Capture is stored in a separate file that 
is named using the date-time file naming format shown on the previous page.
Capture As
Pulse Sensor Time Domain Mode
Same as Capture, only the Capture As dialog box is displayed. Allows the use of a 
unique filename when saving a Time Domain Display Capture to file.
Enable Logging
Used to toggle the logging function on or off. When menu option is blue Logging 
is on, additionally “Logging On” is displayed at the top of the VPM3 
measurement screen. See “Logging” on page 71.
Logging Settings
Opens the Logging Settings dialog box. The Logging Settings dialog box is used to 
configure the logging parameters and select the log file type. See “Logging” on 
page 71 for detailed information on logging.

MMMM_NNNNNNNN_YYYYMMDD_HHMMSS.xml

Model
Serial Number

Year
Month

Day Hour
Minute

Seconds
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Chapter 4 Measurement Modes

Measurement Modes — The following sensor dependent measurement 
modes are available:

 Average Power Mode - All Sensors

 Time Domain Mode - 7022 Sensor Only

 Statistical Power Mode - 7022 Sensor Only

Average Power Mode

In average power mode sensor data may be displayed using any of the display 
types available in VPM3. See “Displays” on page 5. Depending on the 
capabilities of the connected sensor some or all of the following measurements 
may be displayed in Average Power Mode.

Forward and Reflected Power

Average power is a measure of the equivalent “heating” power of a signal, as 
measured with a calorimeter. It measures the total RF power in the system, and 
does not depend on number of carriers or modulation scheme.
Average power is the most important measurement of any transmission system 
since the average power is normally specified on the operating license. It is also 
valuable as a maintenance tool, showing overall system health, and for 
calibration.

Figure 23   Average and Peak Envelope Power, Square Wave Signal
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Match

Match measures the relation between forward and reflected average power. 
The health of the feedline and antenna systems can be monitored using Match, 
or VSWR, measurement under full power operating conditions. High VSWR is an 
indicator of feed line damage, overtightened cable or feed line clamps, or 
antenna changes/damage due to weather conditions, icing, or structural 
damage to the tower.
Rho and Return Loss are also the same measurement, but in different units:

Rho   PR PF=

VSWR 1 p+
1 p–
-------------=

ReturnLoss dB  20 log=

Rho — 

VSWR — 

Return Loss (dB) — 

Forward Peak Power

5012, 5016, 5017, 5018, 5019
Peak power measurements detect amplitude changes as a signal modulates the 
carrier envelope. 
Transmitter overdrive can be detected with peak measurements. Common 
problems are overshoot at the beginning of burst packets, amplitude 
modulation, and excessive transients. These damage system components with 
excessive peak power and also cause data degradation, increasing the Bit Error 
Rate. For TDMA applications, Peak and Burst Power measurements are used to 
detect overshoot in single timeslots. Other timeslots must be turned off for this 
test.

Peak Average Power

5012, 5016, 5017, 5018, 5019
This displays the average of the positive and negative peak power readings.
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Burst Average Power

5012, 5016, 5017, 5018, 5019
Burst width (BW) is the duration of a pulse. Period (P) is the time from the start 
of one pulse to the start of the next pulse. Duty cycle (D) is the percentage of 
time that the transmitter is on. To calculate the duty cycle simply divide the 
burst width by the period (D = BW / P). Low duty cycles mean that the burst 
width is much less than the period; a large amount of dead time surrounds each 
burst. For low duty cycles, the burst average power will be much larger than the 
average power.
After peak power is measured, a threshold of ½ the peak is set. The sampled 
power crosses that threshold at the beginning and end of each burst. The time 
between crossings is used to calculate the duty cycle. Burst Average Power is 
calculated by dividing the Average Power by the Duty Cycle.
Burst average power is calculated in the 7022 automatically using the average 
detector and the duty cycle.
Burst average power can also be calculated in the time domain mode using the 
average power between markers function.
Burst power measurements provide accurate, stable measurements in bursting 
applications such as TDMA and radar. Accurately measuring the output signal 
strength is essential for optimizing radar coverage patterns. Actual transmitted 
power in a single timeslot can be deter-mined in TDMA. The other timeslots 
must be off during this test.

Figure 24   Burst Average Power
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Crest Factor

5012, 5016, 5017, 5018, 5019
Crest factor (CF) is the ratio of the peak and average powers, in dB. The WPS 
calculates the Crest Factor from the Forward Peak and Average Power 
measurements.
Crest factor is becoming one of the most important measurements as 
communication systems move into the digital age. For CDMA and similar 
modulation types the CF may reach 10 dB. If the crest factor is too large, the 
transmitter will not be able to handle the peak powers and amplitude distortion 
will occur. Crest factor can also detect overdrive and overshoot problems. 
Knowing the CF allows end-users to more accurately set base station power and 
lower operating costs.

Figure 25   Crest Factor, 10 dB CDMA Signal, 100 W Peak, 10 W Ave

Complementary Cumulative Distribution Function (CCDF)

5012, 5016, 5017, 5018, 5019
CCDF measures the amount of time the power is above a threshold. This 
threshold is set in the Configure, CCDF Factor menu. Equivalently, it is the 
probability that any single measurement will be above the threshold. The WPS 
samples the power over a 300 ms window and compares it to a user-specified 
threshold, in Watts. The time above the threshold relative to the total time is 
the CCDF.
CCDF measurements are most useful for pseudo-random signals, such as 
WCDMA, where a high CCDF means that the transmitter is being overdriven. 
CCDF can also detect amplitude distortion within an envelope caused by 
unwanted modulating signals. In TDMA systems, CCDF indicates the health of 
power amplifier stages and their ability to sustain rated power over an 
appropriate timeframe. As a trouble-shooting aid, CCDF allows tracking of 
trends such as amplifier overdrive (which can cause dropped calls and high bit 
error rates).

Figure 26   CCDF, 100 W Signal, 80 W Threshold, 20% CCDF
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Gated Average

7023
Gated Average measures the average power of a pulse in a user defined interval 
referenced from the rising and falling edges of the pulse. 
When the measurement is initiated 2.23 ms of the signal is sampled. The 
envelope of the signal must contain at least 3 edges within the acquisition 
window in order for pulse parameters to be measured. The edges can be rise-
fall-rise or fall-rise-fall. The pulse repetition rate is measured between two rising 
edges or two falling edges, depending on which edge is detected first. 
The measurement interval for the average pulse power begins at the user 
specified delay after the rising edge (positive integer) and ends at the user 
specified time interval before the falling edge (negative integer). These values 
are entered on the Configure Menu. See “Pulse Gate Times” on page 40.
The rising edge of the pulse is identified at the point where the power envelope 
rises to 10% of the pulse top amplitude. The falling edge of the pulse is 
identified at the point where the power envelope drops to 90% of the pulse top 
amplitude. See Figure 27 on page 54.

Figure 27   Pulse Gate Times

The sensor is capable of averaging measurements from pulse to pulse. See 
“Average Count” on page 40.
The average is an exponential where:

AVGn
1
k
---X n

k 1–
k

-----------AVGn 1–+=

The Averaging Value parameter sets the k factor. 
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The algorithm is an exponential moving average. Pulse related measurements 
(gated pulse power, width, duty cycle, & rep rate) are normally calculated from 
one complete pulse. When the exponential moving average is enabled, the 
pulse measurements are averaged over multiple pulses.
The averaging only applies to pulse related measurements. The moving average 
does not apply to the forward or reflected average power measurements.

State Average

7027, 7029, and 7037
State Average measures the average power of up to four states within a pulse 
period (frame). 
State Average measures:

 Average Power of up to four states within a pulse period (frame).

 Transition time between states within a pulse period.

Begin delay and end delay times are used to define each state. The begin and 
end delay times are referenced to an external sync pulse, or by an internal 
reference, see Figure 28.

Figure 28   State Average Measurements
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In addition to average power for each state, the Bird VPM will also measure the 
length of time it takes to transition from one state to the next. The transition 
times are calculated using the collected sensor data as viewed in the Time 
Domain Display. When a measured signal is transitioning from one state (signal 
level) to another state, user settable reference values are used during the 
transition, then the transition duration, in time, between the two reference 
values is calculated to determine the transition time.

Note: The user may set the reference values used for transition 
time measurement.

As shown in Figure 29, for a positive going signal, (state 1 to state 2) the first 
reference value is taken at a level 10% above the previous state, the second 
reference value is take at 90% above the previous state. The transition time, is 
the rise time between the 10% value and the 90% value.

Figure 29   Transition Times

For a negative going signal, (state 4 to state 1) the first reference value is taken 
at a level 10% below the previous state, the second reference value is take at 
90% below the previous state. The transition time, is the fall time between the 
10% value and the 90% value.
The transition times are displayed on the States Tab in the Measurement Details 
area of the VPM3 display. See "States Tab" on page 17.
Analysis Mode
7027, 7029, and 7037
The configuration of the State Average measurement defaults to an automatic 
process called Analysis Mode. The Analysis Mode process automatically 
determines the begin and end delay times for all states within the pulse period. 
The automatic setting for Analysis Mode may be turned off and the begin and 
end delay times manually set if desired (see "Manually Determining Begin and 
End Delay Times" on page 59). 
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In time domain mode, clicking the Auto Config button (see "State Configure 
Menu" on page 28) will automatically configure:

 Begin and End delay times for up to 4 states.

 Reference points for transition time measurement.

There are four settings that may be adjusted by the user to customize the 
measurements.

Note: These settings are only active when Analysis Mode is set to 
Auto.

 State Begin Margin: This setting specifies when a states average power 
measurement will begin. Expressed as a percentage of the states total 
width, the average power measurement will begin at the specified 
percentage from the beginning of the state. See Figure 30.

 State End Margin: This setting specifies when a states average power 
measurement will end. Expressed as a percentage of the states total 
width, the average power measurement will end at the specified 
percentage from the end of the state. See Figure 30.

 State Upper Reference: This setting specifies the upper reference point 
used when calculating transition times. Expressed as a percentage of 
the total transition, the transition time will begin (or end) at the speci-
fied percentage from the bottom of the transition. See Figure 31.

 State Lower Reference: This setting specifies the lower reference point 
used when calculating transition times. Expressed as a percentage of 
the total transition, the transition time will end (or begin) at the speci-
fied percentage from the bottom of the transition. See Figure 31.

Figure 30   

State Begin Margin

% after Beginning of Pulse

State End Margin
% from End of Pulse

Measurement
Interval

State Measurement Interval Margin Settings
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Figure 31   Transition Time Reference Settings

State Lower Reference

% from bottom of Pulse

State Upper Reference

% from Top of Pulse

Transition
Time

State Begin/End Delay Times Screen Annotations
7027, 7029, and 7037
After begin and end delay times are configured for a state, the begin and end 
delay times are displayed on the Time Domain Display in the format shown in 
Figure 32. In addition to changing these values using State Configure Menu 
("State Configure Menu" on page 28), the begin and end times may also be 
changed by “dragging” the associated vertical line to a new position.

Note: If a begin or end time delay line is moved, Analysis Mode 
will be set to Manual Mode.

Figure 32   State Begin/End Delay Time Screen Annotations
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Manually Determining Begin and End Delay Times
7027, 7029, and 7037
In Manual Analysis Mode the average pulse power measurement interval for 
each state begins at the user specified begin time and ends at the user specified 
end time. There may be four different states specified, each with a begin and 
end time. These values are entered on the State Configure Menu, See 
Figure 33.
Once the Pulse Sensor is connected, begin and end delay times can be 
determined manually with Analysis Mode in Manual. 
For each state to be measured within the pulse period, move the upper and 
lower markers to the beginning and end of a state, see Figure 33 State 1. The 
time displayed at the marker positions can be used to set the begin and end 
delay time for the state at the marker position. Move the markers to each state 
to be measured to determine begin and end delay times for all states.

Figure 33   State Average Begin and End Times
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Time Domain Mode

7022 (7027, 7029, and 7037 see "State Average" on page 55)
In Time Domain Mode, the amplitude of a single frequency is measured, rather 
than sweeping a range of frequencies. The Sensor measures the amplitude of 
the frequency for a specified period (sweep time) and refreshes during the next 
sweep. VPM3 displays the Time Domain trace on the Chart Display.

Figure 34   Time Domain Display

The Statistical Power Sensor time domain mode operates very much like a 
modern digital oscilloscope that has its vertical axis is accurately calibrated in 
power. The VPM3 can display the following 7022 Sensor measurements: 

 Peak (Envelope) Power

 Burst Power

 Power at Marker

 Power between Markers

The 7022 Sensor can also measure and VPM3 display pulse characteristics such 
as:

 duty cycle

 overshoot

 pulse width

 rise time

 fall time

 off time

 edge delay
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 pulse period 

 repetition rate

See “Measurement Menu” on page 29 for additional information on 7022 
Measurements.
Time base and trigger functions are available to present a stable time domain 
graphic. See See “Trigger Menu” on page 31.
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Statistical Power Mode

7022
Most modern wireless communication systems employ complex modulation 
and channel access methods like orthogonal frequency division multiplexing 
(OFDM), or code division multiple access (CDMA). These methods use a 
combination of amplitude and phase modulation to create symbol based 
multichannel or multicarrier systems that result in pseudo-random or noise-like 
power envelopes. The consequence is that modulation parameters such as AM 
depth or FM modulation index are not useful. Indeed, the peak-to-average 
power ratio of the modulated carrier is a complex function of the data stream 
content rather than just amplitude, and as such is not constant with time. Since 
digitally modulated signals often appear noise-like it makes sense to use 
statistical analysis in order to characterize them.
The most significant advantage RF Power meters that provide measurements 
based upon statistical methods is that they are capable of making meaningful 
power measurements of signals incorporating complex modulation methods. In 
essence, provide meaningful measurements independent of the modulation 
method used in the system.

Statistical Power Measurement

Provides statistical measurements to display the percentage of time that a 
particular waveform exists at a specific peak to average power ratio. The 
Figure 35 on page 63 illustrates this concept, as applied to an LTE-TDD 
waveform.
In Figure 35 the horizontal axis represents the peak to average power ratio of 
the waveform being measured. The vertical axis on the display represents time 
in percent. Reading a specific point on the graph provides information as to the 
percentage of time that the signal being measured exhibits a specific peak to 
average power ratio characteristic.
The performance curve illustrated in Figure 35 indicates that the maximum 
peak to average ratio of the waveform being measured is indicated at the point 
where the curve intersects the horizontal axis. This corresponds to a value of 
11.5 dB.
Two movable cursors are available within the VPM3 display. These cursors may 
be located at any point on the curve, in order to determine specific values of the 
waveform peak to average ratio, and corresponding time.
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Figure 35   VPM Statistical Power Display

This table represents a few of the statistical curve data points in
numeric format.

Time (%) Peak/Average Ratio (dB)

Interpreting Statistical Data
There are many factors that influence the performance of modern 
communications systems. Some examples:

 The presence of interfering signals within the operating bandwidth of 
the system.

 Transmission line discontinuities resulting in multiple reflections within 
the transmission system.

 Poor amplifier linearity caused by amplifier compression. This results in 
signal distortion and poor fidelity of transmitted waveforms.

 Antenna damage or degradation resulting in high transmission system 
reflections. 

 Issues with transmitter modulator performance resulting in high error 
vector magnitude (EVM).

Many of the above transmission system issues may be identified through the 
use of the statistical techniques mentioned above. For example, if a particular 
LTE radio system was known to be dropping calls at a higher rate than expected, 
a service technician will need to know whether the problem is with the radio 
itself, or with some element of the transmission system, or with the air 
interface. 

10% 4.8
1% 7.5
0.1% 9.6
0.01% 10.6
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Measuring the statistics of the base station radio, while terminated with a high 
quality 50 ohm termination, and then again with the radio connected to the 
transmission and antenna system will provide clues as to where the issues may 
be.
Another useful technique is to compare live data from the system with a known 
“reference” transmission.
Loading a Reference Measurement in VPM3
With a statistical measurement displayed a reference measurement may be 
displayed for comparison. A previous statistical measurement must have been 
saved and be accessible in the path selected in preferences for saving 
measurements, the default path is: \Documents\VPM3\Measurements.
1. Click File, hover over Open, then select Reference Measurement.

Figure 36   Open File

2. Select the reference statistical measurement. 

Figure 37   Reference Measurement File Selection

3. Click Open.
Reference Measurement is displayed on the chart with the live measurement, a 
marker table displays the trace differences at the marker positions.

Figure 38   Reference Measurement Chart Display
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Sessions

Session files are used to initialize VPM3 when a Bird Power Sensor is connected. 

Generic Session File

Initially when power sensor is connected to the VPM3, if it has never been 
connected to VPM3 before, a generic session file is used to configure the 
sensor. The initial settings for any sensor, the first time it is connected, is all 
settings are defaulted with data acquisition enabled.
When a first time sensor is initialized it will typically display forward average 
power on the digital display. Once the sensor session begins VPM3 
automatically creates a Serial Number specific session file.

Note: Generic Session files cannot be modified, but a Default Ses-
sion File with custom settings can be created to initialize sensor 
settings for sensors of the same type when first connected. See 
“Default Session Files” on page 65.

Serial Number Specific Session Files

Serial Number Specific Session Files are automatically created whenever a 
Power Sensor is connected to VPM the first time. Any changes made to the 
configuration of the power sensor will be saved in the Serial Number Specific 
Session File. When the sensor is connected to VPM3 in the future the serial 
number specific session file will be used and the sensor configuration will be 
initialized using the settings when the sensor’s last session was closed.

Default Session Files

A Default Session File is a customized session file that may be created using a 
preferred setup for all sensors of the sensor type currently connected in active 
session. 
If a default session file has been created for a type of sensor, when a sensor of 
that type is connected to VPM3 and has not been connected before, the default 
session file is used to initialize the sensor.
For details on how to create a default session file. See “Save a Default Session 
File” on page 88.
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New Sensor Session

Whenever a sensor is connected, before a session can begin, the sensor must be 
detected by VPM3. VPM3 uses a connection manager to display the Select 
Sensor(s) dialog box (Figure 39). All Bird sensors connected to the computer will 
be listed. 

Note: If a sensor is already connected and in a session it will not 
be listed in the Select Sensor(s) dialog box.

Depending on preferences, a sensor must be manually selected from the list, or 
VPM3 will automatically launch sessions for ALL the sensors in the list. See 
“Preferences” on page 21 for details about changing sensor connection 
behavior.
Selecting a New Sensor Session does not close any active sensor window/
connection. 
See “Connecting VPM3 to a Sensor” on page 73 for steps required to start a 
new session.

Figure 39   Select Sensor(s) Dialog Box

Legacy Preset Files

Preset files are a legacy file type previously used in VPM3. This file was used in 
previous versions in the same way that Default Session Files and Serial Number 
Specific Session Files are used in the current VPM3.
Legacy Preset files may be saved as a Default Session file for use in current 
versions of VPM3.
To convert a legacy preset to a Default Session File, see "Convert Legacy Preset 
File to Default Session File" on page 89.
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Limit Indicators

The Analog and Digital Displays have limit indicators that may be set to provide 
a visual indication the measurement is above or below specified values.

Figure 40   Limit Indicators

The circular limit indicators shown in Figure 40 are on both the Analog and 
Digital Displays in the upper left corner of the display. These indicators are 
normally green indicating the signal has not exceeded a user specified limit. 
When a limit is exceeded the indicator will change to red, see Figure 41.

Figure 41   Exceeded Limit Indications

The Limit indicators on the Digital Displays bar graph (Figure 40, bottom) are 
static indicators only, they are simply mark the portion of the displayed range 
that is above or below the user specified limits. 
See “Setting Limit Indicators” on page 90 for a procedure to set limits using 
the "Measurement Menu".
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Data Buffering 

When a sensor is connected to VPM3, and a measurement is started “Data 
Stream On” is displayed at the top of the sensor session window.

Figure 42   Data Stream On Indicator

When the data stream is on, all the data collected is buffered up to the limits set 
in the preferences dialog box. The Default settings for data buffering are:

 1000000 Points (Chart History)

 1000 Frames (Playback History)

Data is buffered to the limit set in preferences, once the limit is reached data 
continues to be buffered but the oldest data is dropped from the buffer. The 
purpose of data buffering is to provide the ability to playback data without 
opening a log file. See “Playback” on page 70 for details about the playback 
function.
Buffered data is only available while the sensor is connected and a session is 
active. 

Note: Buffered data may be cleared at anytime during a session 
by clicking on the View menu, selecting Playback and Clear Buffer. 
Buffered data is also cleared when Restart Session on the Log 
Menu is used.

Frames

Frames are similar to a snapshot of the data stream (see "Snapshots" on 
page 69). A frame is a set of measurement data viewed on one of the VPM3 
displays. Each frame is a collection of the data received from the sensor. 

Points

Points are equivalent to frames but are only relevant to the chart. Because of 
this data buffering can also be used to effect how measurements are displayed 
on the chart. The settings used in preferences can be used in a fashion similar to 
the Time/Division adjustment on an Oscilloscope.
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For example the two displays shown in Figure 43 are of the same signal input at 
the sensor. The difference is the settings for Chart points and Playback settings. 
The settings for these values are can have a significant impact on the chart 
displays resolution.

Figure 43   Chart Points vs. Frames

Snapshots

Note: Save Measurement Snapshot and Save Measurement 
Snapshot As capture the most recent measurement readings. It will 
not store the chart information. To store chart display, enable log-
ging. See “Logging” on page 71.

Save Measurement Snapshot
Save Measurement Snapshot is an option on the File Menu. This option is also 
available on the control panel File button, as Save option. Clicking the Save 
option or save measurement Snapshot option creates a snapshot of the data 
readings displayed on the screen (one frame). The data is saved as an XML file. 
The snapshot is saved in the measurement file folder (the default directory is 
\Documents\VPM3\Measurements).
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Each snapshot is saved as a separate file that is named using the following 
format:

MMMM_NNNNNNNN_YYYYMMDD_HHMMSS.xml

Model
Serial Number

Year
Month

Day Hour
Minute

Seconds

Save Measurement Snapshot As
Save Measurement Snapshot As saves the same information as the Save 
Measurement Snapshot option, the difference is this option opens a dialog box 
so a unique name can be given to the snapshot. 

Playback

The playback function within VPM3 allows the playback of either buffered data 
or log files.
Playback is controlled using the playback controls at the bottom of the Sensor’s 
session screen. The function of each button is shown in Figure 44 on page 70. 

Figure 44   Playback Controls

Buffered data can be viewed at any time by stopping data acquisition and using 
the playback controls. To playback click the First Frame or Previous Frame 
button to “rewind” the frames, then click play.
To playback a log file, the log file must be opened, then the playback controls 
may be used to navigate through the data. When playing back a log file the data 
may be viewed on any display normally available for the sensor that captured 
the data. For sensors that have different modes available, the mode cannot be 
changed, the playback mode is determined by the recorded data.
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Logging

Measurement logging is a powerful tool for monitoring and tracking system 
performance. Storing the readings enables the ability to graph the output over 
time, know the exact time of a failure, or compare systems.
The VPM3 can be set up to take many readings over a short test period, to take 
a few readings a day for long-term monitoring, to log only while the transmitter 
is on, or to log when power spikes or drops below a critical value, depending on 
specific needs. 
Logs can be saved in the following formats:

 XML - XML is the only format that can be played back by VPM3. XML 
files can also be opened in spreadsheet software.

 CSV - Measurements are saved in a text file, these files cannot be 
opened by VPM3, they must be viewed in a spreadsheet or text reader.

 PDF - Measurements are saved in a timestamped-columnar format 
which can be read in a PDF reader.

Log files are stored in the default log file directory under Documents/VPM3/
Measurements. See “Creating Log Files” on page 94 for instructions in saving 
logs.
VPM3 playback function may be used to display log files that have been saved in 
XML format. 

Log Contents

Sensor readings may be logged to a file for future external analysis or archiving 
purposes. The logged data is in general a sampled subset of the data received 
from the sensor, selected by the log conditions specified in the Log Settings 
Dialog, see "Logging Settings" on page 72. 
Each sensor provides readings to VPM3, some or all of these readings may be 
logged. The readings that are logged vary depending on the sensor attached to 
VPM3 and the selections made in logging settings.
Figure 45 on page 72 shows the contents of a typical log file (CSV file displayed 
in MS Excel). 
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Figure 45   
*Session:*
*Session Start Time:* 2016 10 24 14:46:05 04:00
*Log Created:* 2016 10 24 14:46:05 04:00
*Sensor Model:* 7023 1 594301 1212
*Sensor SN:* 162601564
*Sensor Software Version:* 1.2.21245 (2015/12/11 18:00:46)
*Sensor Software Build Date:* 7/21/2016
*Properties*:
*Measurement* ForwardAverage
*Input Offset* 0 dB
CorrectionFrequency 13.56 MHz
CorrectionFrequencyAutoEnabled TRUE
*Edge Delay* 9 us
*Edge Delay* 9 us
MeasurementMode AveragePower

*Mode specific Properties*:

*Limits*:

*Sensor Data:*
*Timestamp* ForwardPower ReflectedPower GatedPower Frequency Temperature DutyCycle PRF

540131 2.94E 03 2.79E 03 0.00E+00 0.00E+00 2.30E+01 2.02E+00 1.27E+05
540366 2.93E 03 2.79E 03 0.00E+00 0.00E+00 2.30E+01 2.02E+00 1.27E+05
540530 2.93E 03 2.79E 03 0.00E+00 0.00E+00 2.30E+01 2.02E+00 1.27E+05
540700 2.93E 03 2.79E 03 0.00E+00 0.00E+00 2.30E+01 2.02E+00 1.27E+05
540864 2.93E 03 2.79E 03 0.00E+00 0.00E+00 2.30E+01 2.02E+00 1.27E+05

Typical Log File Content

Logging Settings
Logging settings can be used to change when a log file is started, ended, and the 
amount data collected.
There are three main options in the logging settings dialog:

 When measurements are logged, continuously or only under certain 
conditions.

 How Long measurements are logged, limited by time or indefinitely.

 What additional measurement data is included, averaging options 
allow the logging of additional variations of sensor data. 

Continuous Logging. 
Data may be logged continuously, by selecting Log measurements 
continuously at the given Interval, subject to a the interval set using the 
Sampling Interval setting. A complete set of data is recorded in the log 
repeating at the selected interval.

A selection is available to log data indefinitely or to limit logging to a 
specified number of frames. If frames are selected, the logging duration 
(HH:MM:SS) will be displayed below the option.

Conditional Logging. 
When Use conditional logging is selected, data is only logged when the 
specified conditions are met. Any of the sensor measurements may be to 
set to trigger logging when the measurement goes above or below the 
selected value.

A selection is available to log a single measurement or log continuously 
once the condition is met.
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Connecting VPM3 to a Sensor

Note: Refer to the individual power sensor manual for specific 
information regarding sensor RF connections.

1. Launch VPM3.
Note: The power sensor may be connected prior to launching 
VPM3.

2. Connect a power sensor to the computer’s USB port with a USB cable.
Note: Bird USB sensors are HID compliant devices and do not 
require driver installation. The exceptions are the 7022 STAT power 
sensor and the 7023 pulse sensor which require an installed driver.

Note: The 5014 and 5015 sensors LED will illuminate continually 
when properly recognized by the host PC.

Note: The 5012B, 5016B, 5017B, 5018B, and 5019B sensors LED 
will blink when properly recognized by the host PC.

Note: The 402X series sensors require the use of the 4421B540-2 
Sensor Interface Module.

3. If Sensor does not connect automatically perform one of the following 
based on selected Preferences:
 Select the sensor from the list of available sensors in the Select Sensor 

Dialog and click Connect.
 Click File > New Sensor Session.... Select the sensor from the list of 

available sensors in the Select Sensor Dialog and click Connect.

Note: For details about changing sensor connection behavior see 
"Preferences" on page 21.

Note: Multiple sensors can be connected and/or monitored simul-
taneously through multiple USB ports or via a powered USB hub. It 
can take up to 30 seconds to detect a sensor.

Figure 46   Sensor Connection Manager
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402X DPS Setup

Connecting the 402X Series DPS

1. Connect the Bird 402X Series DPS to the 4421B540-2 Sensor Interface 
Module using the sensor cable provided.

2. Connect the 4421B540-2 Sensor Interface Module to the a USB port on the 
PC using a USB cable.

Figure 47   402X Power Sensor Cable Connections

LOAD

– CAUTION –
1200 WATTS MAX.

SOURCE LOAD

Sensor Interface Module
4421B540-2

402X DPS Measurements

After VPM3 connection is established here are a few things to check:

 Click Configure button, If couplers or attenuators were used when 
making RF connections:

 Enter the offset value, see "Input Offset" on page 24.

 Click Measurement button:

 Select desired measurement type, see "Type:" on page 42.

 Start Measurement (if not automatically started), see "Stop/
Start" on page 42.

 Click Units button:

 Select Power Units to display, see "Power:" on page 46.

 Select Match Units to display, see "Match:" on page 46.
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 Click File button:
If you wish to save snapshots or log any measurements use this menu

 Establish Logging Settings, see "Logging Settings" on page 49.

 Enable Logging, see "Enable Logging" on page 49.

5014 DPS Setup

Connecting the 5014 DPS

1. Connect the Bird DPS to the a USB port on the PC using the sensor cable 
provided.

Figure 48   5014 Power Sensor Cable Connections

5014 DPS Measurements

After VPM3 connection is established here are a few things to check:

 Click Configure button:

 Enter the offset value (if couplers or attenuators were used when 
making RF connections), see "Input Offset" on page 37.

 Select Element type, see "Elements" on page 38.

 Enter Forward Scale (Forward Element), see "Forward Scale" on 
page 38.

 Enter reflected scale OR Click F/R Scale 10:1 ratio, see “Reflected 
Scale” and “F/R Scale 10:1 Ratio” on page 38
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 Click Measurement button:

 Select desired measurement type, see "Type:" on page 42.

 Start Measurement (if not automatically started), see "Stop/
Start" on page 42.

 Click Units button:

 Select Power Units to display, see "Power:" on page 46.

 Select Match Units to display, see "Match:" on page 46.

 Click File button:
If you wish to save snapshots or log any measurements use this menu

 Establish Logging Settings, see "Logging Settings" on page 49.

 Enable Logging, see "Enable Logging" on page 49.
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5015, 5015-EF TPS Setup

Connecting the 5015, 5015-EF TPS

1. Connect the Bird TPS to the a USB port on the PC using the sensor cable 
provided.

Figure 49   5015 Power Sensor Cable Connections

5015, 5015-EF TPS Measurements

After VPM3 connection is established here are a few things to check:

 Click Configure button, If couplers or attenuators were used when 
making RF connections:

Note: For TPS-EF sensors, correction factors are required when 
measuring RF above 4 GHz. See “5015-EF Correction Factors” on 
page 78.

 Enter the offset value, see "Input Offset" on page 24.

 Click Amplitude button:
Before accurate measurements can be taken, “zero” the sensor.

 Click Zero, see "Zeroing a Sensor" on page 97

 Click Measurement button:

 Start Measurement (if not automatically started), see "Stop/
Start" on page 42.

 Click Units button:

 Select Power Units to display, see "Power:" on page 46.

CAUTION
Ensure RF Power is OFF before zeroing a sensor.
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 Click File button:
If you wish to save snapshots or log any measurements use this menu

 Establish Logging Settings, see "Logging Settings" on page 49.

 Enable Logging, see "Enable Logging" on page 49.

5015-EF Correction Factors

The Bird 5015-EF uses frequency-dependent correction factors to improve its 
accuracy. To use the correction factors:
1. Look at the Correction Factor table on the side of the TPS and find the 

correction factor corresponding to the frequency under test.
2. Add the correction factor to all other necessary offsets (for example, the 

coupling factor of a directional coupler).
3. Input the Offset on the VPM3. See “Input Offset” on page 37.

Note: Correction factors are only required above 4 GHz. Below 
4 GHz, the TPS-EF can be used as a normal TPS. 
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5012, 5016, 5017, 5018, 5019 WPS Setup

Connecting the 5012, 5016, 5017, 5018, 5019 WPS 

Note: WPS Firmware V1.45 or later is required to operate with 
VPM3. For the latest firmware upgrade, contact Bird Customer Ser-
vice at (866) 695-4569 or visit the Bird website at http://www.bir-
drf.com.

Figure 50   5012, 16, 17, 18, 19 Power Sensor Cable Connections

1. Connect the Bird WPS to the a USB port on the PC using the sensor cable 
provided.

5012, 5016, 5017, 5018, 5019 WPS Measurements

After VPM3 connection is established here are a few things to check:

 Click Configure button, If couplers or attenuators were used when 
making RF connections:

 Enter the offset value, see "Input Offset" on page 24.

Note: Entries required on this menu will vary depending on the 
measurement type selected. see "Configure Button" on page 37 
for details of the option available.

 Click Amplitude button:
Before accurate measurements can be taken, “zero” the sensor.

 Click Zero, see "Zeroing a Sensor" on page 97 for additional 
information.

CAUTION
Ensure RF Power is OFF before zeroing a sensor.
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 Click Measurement button:

 Select desired measurement type, see "Type:" on page 42.

 Start Measurement (if not automatically started), see "Stop/
Start" on page 42.

 Click Units button:

 Select Power Units to display, see "Power:" on page 46.

 Select Match Units to display, see "Match:" on page 46.

 Click File button:
If you wish to save snapshots or log any measurements use this menu

 Establish Logging Settings, see "Logging Settings" on page 49.

 Enable Logging, see "Enable Logging" on page 49.
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7020 WPS Setup

Connecting the 7020 WPS

Figure 51   7020 Power Sensor Cable Connections

1. Connect the Bird 7020 WPS to the a USB port on the PC using the sensor 
cable provided.

7020 WPS Measurements

After VPM3 connection is established here are a few things to check:

 Click Configure button, If couplers or attenuators were used when 
making RF connections:

 Enter the offset value, see "Input Offset" on page 24.

 Click Amplitude button:
Before accurate measurements can be taken, “zero” the sensor.

 Click Zero, see "Zeroing a Sensor" on page 97 for additional 
information.

 Click Measurement button:

 Select desired measurement type, see "Type:" on page 42.

 Start Measurement (if not automatically started), see "Stop/
Start" on page 42.

 Click Units button:

 Select Power Units to display, see "Power:" on page 46.

 Select Match Units to display, see "Match:" on page 46.

CAUTION
Ensure RF Power is OFF before zeroing a sensor.
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 Click File button:
If you wish to save snapshots or log any measurements use this menu

 Establish Logging Settings, see "Logging Settings" on page 49.

 Enable Logging, see "Enable Logging" on page 49.

7022 Statistical Power Sensor Setup

Connecting the 7022 Statistical Power Sensor 

Figure 52   7022 Power Sensor Cable Connections

1. Connect the Bird SPS to the a USB port on the PC using the sensor cable 
provided.

2. Verify the power sensor’s device driver is installed correctly (\\Control 
Panel\Hardware and Sound\Devices and Printers).

7022 Statistical Power Sensor Measurements

Note: Firmware upgrades extending the SPS’s capabilities may be 
periodically released. For the latest firmware upgrade, contact Bird 
Customer Service at (866) 695-4569 or visit the Bird website at 
http://www.birdrf.com.

After VPM3 connection is established here are a few things to check:

 Click on the Mode Menu:

 Select the mode of operation, see "Mode Menu" on page 23
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 Click Configure button, If couplers or attenuators were used when 
making RF connections:

Note: Entries required on this menu will vary depending on the 
measurement type selected. see "Configure Button" on page 37 
for details of the option available.

 Enter the offset value (Time Domain, Average Power Mode), see 
"Input Offset" on page 24.

 Click Measurement button:
Before accurate measurements can be taken in Time Domain or 
Average Power Mode, “zero” the sensor.

 Click Zero, see "Zeroing a Sensor" on page 97 for additional 
information.

 Select desired measurement type, see "Type:" on page 42.

 Start Measurement (if not automatically started), see "Stop/
Start" on page 42.

 Click Trigger button:

 Triggers are available in Time Domain Mode, see "Trigger 
Button" on page 44 for the options.

 Click Scale button:

 Scale may need to be adjusted in Statistical or Time Domain 
mode, see "Scale Button" on page 47.

 Click Units button:

 Select Power Units to display, see "Power:" on page 46.

 Select Match Units to display, see "Match:" on page 46.

 Click File button:
If you wish to save snapshots or log any measurements use this menu

 Establish Logging Settings, see "Logging Settings" on page 49.

 Enable Logging, see "Enable Logging" on page 49.

CAUTION
Ensure RF Power is OFF before zeroing a sensor.
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7023 Pulse Power Sensor Setup

Connecting the 7023 Pulse Power Sensor 

Figure 53   7023 Power Sensor Cable Connections

1. Connect the Bird Pulse Sensor to the a USB port on the PC using the sensor 
cable provided.

2. Verify the power sensor’s device driver is installed correctly (\\Control 
Panel\Hardware and Sound\Devices and Printers).

7023 Pulse Power Sensor Measurements

Note: Firmware upgrades extending the Semiconductor Pulse 
Sensor’s capabilities may be periodically released. For the latest 
firmware upgrade, contact Bird Customer Service at (866) 695-
4569 or visit the Bird website at http://www.birdrf.com.

After VPM3 connection is established here are a few things to check:

 Click Configure button, If couplers or attenuators were used when 
making RF connections:

Note: Entries required on this menu will vary depending on the 
measurement type selected. see "Configure Button" on page 37 
for details of the option available.

 Enter the offset value, see "Input Offset" on page 24.

 Click Measurement button:

 Select desired measurement type, see "Type:" on page 42.

 Start Measurement (if not automatically started), see "Stop/
Start" on page 42.
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 Click Units button:

 Select Power Units to display, see "Power:" on page 46.

 Select Match Units to display, see "Match:" on page 46.

 Click File button:
If you wish to save snapshots or log any measurements use this menu

 Establish Logging Settings, see "Logging Settings" on page 49.

 Enable Logging, see "Enable Logging" on page 49.
85



VPM3-MSP Operation Manual
7027, 7029, and 7037 Pulse Power Sensor Setup

Connecting the Pulse Power Sensor 

Figure 54   7027, 7029, and 7037 Power Sensor Cable Connections

1. Connect the Bird Pulse Sensor to the a USB port on the PC using the sensor 
cable provided.

2. Verify the power sensor’s device driver is installed correctly (\\Control 
Panel\Hardware and Sound\Devices and Printers).

Pulse Power Sensor Measurements

Note: Firmware upgrades extending the Semiconductor Pulse 
Sensor’s capabilities may be periodically released. For the latest 
firmware upgrade, contact Bird Customer Service at (866) 695-
4569 or visit the Bird website at http://www.birdrf.com.

After VPM3 connection is established here are a few things to check:

 Click Configure button, If couplers or attenuators were used when 
making RF connections:

Note: Entries required on this menu will vary depending on the 
measurement type selected. see "Configure Button" on page 37 
for details of the option available.

 Enter the offset value, see "Input Offset" on page 24.

 Click Sync button:

 Select sync source, "Sync Button" on page 45.

 (External Sync) Select Rising/Falling Edge.

(Internal Sync) Select Auto or specify a power level for state 
measurement start.
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 Click Scale button, if State Average measurement (see "State Average" 
on page 55 ) is chosen:

 Adjust Time, Offset, Power as necessary to display the signal.

 Adjust Sweep Time or Sweep Delay, if required, to display all 
state transitions.

 Analysis Mode Selection:
 For Auto configuration, click Auto Config button.
Click Analysis Settings (see "State Average" on page 55), accept 

the default auto configuration or specify the following:
State Begin Margin 
State End Margin 
State Upper Reference 
State Lower Reference 
State Sensitivity

 For Manual configuration, click State Configure button, if State Aver-
age measurement (see "State Average" on page 55 ) is chosen:

 Click State Select Option, select state to configure (1 -4).

 Enter a State Begin time.

 Enter a State End Time.

 Click State Enable.

 Repeat for up to four States.

 Click Measurement button:

 Select desired measurement type, see "Type:" on page 42.

 Start Measurement (if not automatically started), see "Stop/
Start" on page 42.

 Click Units button:

 Select Power Units to display, see "Power:" on page 46.

 Select Match Units to display, see "Match:" on page 46.

 Click File button:
If you wish to save snapshots or log any measurements use this menu

 Establish Logging Settings, see "Logging Settings" on page 49.

 Enable Logging, see "Enable Logging" on page 49.

Use Capture to save data displayed in Time Domain graphical 
display, see "Capture" on page 49.
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Open Session File

A session file contains configuration settings for a single type of sensor, or a 
specific serialized sensor. Session files, when opened, will modify the settings of 
the Bird Power Sensor currently connected to VPM3, these files may be used for 
a “preset” configuration. A detailed explanation of session files can be found in 
“Theory of Operation” on page 65.

Note: Opening a session file will modify current sensor settings (if 
different) to the settings saved in the session file being opened.

Note: A sensor must be connected to open a session file.
1. Click File, and hover the cursor over Open, then select Session...
2. Double click on the folder for the type of sensor (sensor family). 
3. Select the session file that will be used to configure the currently connected 

sensor.
4. Click Open.

Save a Default Session File

A default session file can be used to save configuration settings for a single type 
of sensor. Session files, when opened, will modify the settings of the Bird Power 
Sensor currently connected to VPM3, these session files may be used as a 
“preset” configuration for other sensors of the same type. A detailed 
explanation of session files can be found in “Theory of Operation” on page 65.
1. Configure the currently connected sensor with the settings desired for use 

as the preferred initial settings.
2. Click File, and select Save Session As...
3. Click Save in the Save Session As dialog box, to save the session with the file 

name defaultsession.xml.
defaultsession.xml is the default name assigned for the session file, 
this is the file name VPM3 will automatically search for and use when 
a new sensor is connected (unless a serial number specific session file 
is available). If the default name of the file is changed, the default 
session must be manually opened to effect new sensor connections, 
see "Open Session File" on page 88.

Open Measurement File

Measurement files consist of two basic types, snapshot and log. see 
"Snapshots" on page 69, and “Logging” on page 71. To open a measurement 
file in VPM3 it must be in XML format. Opening a measurement file will open a 
session window in playback mode.
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Note: Measurement files may be opened without a sensor con-
nected to VPM3.

1. Click File, and hover the cursor over Open, then select Measurement...
A Log Browser will open with a table displaying all the saved 
measurements in the VPM3 measurements folder.

2. Click Refresh, to update the list of measurements.
3. Select the desired measurement from the list.

If the measurement is not located in the VPM3 measurements folder 
click the browse button  and navigate to the file.

4. Click Open.
See “Viewing Data Using VPM3 Playback” on page 92 for details on 
using playback.

Convert Legacy Preset File to Default Session File

Legacy Presets are default preset (default Session) files used in previous 
versions of VPM3 (revision 3.2.22215 and earlier). This procedure provides the 
steps to convert presets to default session files for use in current versions of 
VPM3.

Note: A sensor must be connected to open a session file.

Note: Opening a preset file will modify current sensor settings (if 
different) to the settings saved in the preset file being opened.

1. Save the legacy preset file in the VPM3 Presets folder, if not already there 
(the default directory is \Documents\VPM3\Presets). 

2. Click File, and hover the cursor over Open, then select Session...
3. Navigate to the Presets directory \Documents\VPM3\Presets.
4. Select the legacy preset.
5. Click Open. 

The preset file will open and update the current sensor session to 
settings specified in the preset.

6. Click File, and select Save Session As...
7. Click Save in the Save Session As dialog box, to save the session with the file 

name defaultsession.xml.
Note: The default session file will be saved in the appropriate 
folder for the current sensor family.
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Setting Limit Indicators

Note: Limits menu is NOT available for the 7022 or 7023 sensors.
Limits can be used to aid in visual identification of measurements falling outside 
a desired range. Limit indicators are available on the Analog and Digital displays 
see "Limit Indicators" on page 67 for more information on the limit indicators.

Add a Limit

To add a measurement limit perform the following steps:
1. Click the Measurement menu and select Limits... to display the Limits 

dialog box.

Figure 55   Limits Dialog Box

2. Click Add Limit to display the Add Limit... dialog box.

Figure 56   Add Limit Dialog Box

3. Select the Measurement for which the limit will apply.
4. Select the Limit Type.
5. Select the units to apply to the limit value. 
6. Click Add.
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Figure 57   Setting Limit Value

7. Click on the Value entry for the limit. 
8. Type a value for the selected limit.

Note: The edit symbol in the first column indicates a change has 
been made but has not been “finalized” by pressing Enter or click-
ing OK.

9. Click OK.

Edit a Limit

Note: Only the value of an existing limit may be changed.
To change a measurement limit perform the following steps:
1. Click the Measurement menu and select Limits... to display the Limits 

dialog box.
2. Click on the Value entry for the limit to be changed. 
3. Type a new value for the selected limit.

Note: The edit symbol in the first column indicates a change has 
been made but has not been “finalized” by pressing Enter or click-
ing OK.

4. Click OK.

Remove a Limit

1. Click the Measurement menu and select Limits... to display the Limits 
dialog box.

2. Click on the limit to be removed to highlight the entry. 
3. Click Remove Limit.
4. Click OK.
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Viewing Data Using VPM3 Playback

VPM3 buffers active data and provides the ability to save and log measurement 
data. The playback function can be used to review both buffered data and/or 
logged data.

Viewing Buffered Data

Buffered data is not persistent. If a session is ended, the buffered data is erased.
Note: Buffered data may be cleared at anytime during a session 
by clicking on the View menu, selecting Playback and Clear Buffer. 
Buffered data is also cleared when Restart Session on the Log 
Menu is used.

To review buffered data:
1. Click the Measurement menu and select Stop Acquisition. 
2. Click the First Frame or Previous Frame button on the playback controls. 
3. Click Play.

Playback will start from the frame shown on the controls through the 
last frame buffered (default 1000 frames). 

Figure 58   Playback Controls

4. Click Stop at anytime to view a single frame of data.
During Playback these options are available:

 Save a snapshot of any frame, click the File menu, then Save 
Measurement Snapshot. 

 Change Display Type, click the View menu, then hover over Display 
Style and select another display.

 Stop playback, click the Measurement menu and select Start Acquisi-
tion.

 End the session, click the File menu, then Close Session. 
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Viewing Logged Data

Logged data is persistent. Measurement Logs are saved in the VPM3 
measurements folder (default \Documents\VPM3\Measurements). Log files 
may be played back anytime, there is no need to connect a sensor to view 
logged data.

Note: Only log files saved as .xml can be opened and viewed in 
the VPM3. 

Note: Logging must be enabled for log files to be saved, See “Cre-
ating Log Files” on page 94.

To display a log file for playback:
1. Open a Log file. See “Open Measurement File” on page 88.

Select a measurement with “Log” in the Type column of the file list.
2. Click Play.

Log files may be minutes or hours long. If searching for specific events 
it may be useful to view the logged data in the chart display.

3. Click the First Frame, Previous Frame, Next Frame buttons on the playback 
controls at anytime to change view.

4. Click Stop at anytime to view a single frame of data.
During Playback these options are available:

 Set a delay between frames (Slow Mo), click the View menu, then 
hover over Playback and select a delay of 1, 2, 4, or 8 seconds between 
frames.

 Save a snapshot of any frame, click the File menu, then Save Measure-
ment Snapshot. 

 Change Display Type, click the View menu, then hover over Display 
Style and select another display.

 End the session, click the File menu, then Close Session. 
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Creating Log Files

To begin logging:
1. To configure the logging options, click the Log menu, then select Settings...
2. Select the desired options:

 Log File Format: XML, CSV, PDF.

 Log Continuously or only under certain conditions.

 Select duration of the Log.

 Configure Averaging (7023 Only)

3. Click OK.

Figure 59   Logging Settings

4. Begin logging by selecting Enable Logging.
Note: When logging is active, in the upper right of the sensor ses-
sion will display “Logging On.”

5. Stop logging by selecting Enable Logging.
Logging can be started and stopped as often as desired.

After logging is complete, XML data can be reviewed in VPM3, see "Viewing 
Logged Data" on page 93.
Logs may also be viewed as text or in spreadsheets. see "Viewing 
Measurement Logs Outside VPM3 " on page 95.

Note: Log files are stored in the default log file directory under  
:Documents/VPM3/Measurements.
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Viewing Measurement Logs Outside VPM3 

The simplest way to view logged data is to recall in VPM3. See “Viewing Logged 
Data” on page 93.

Note: Only log files saved as .xml can be opened and viewed in 
the VPM3. Files saved in comma-separated format (CSV) can be 
read by most common spreadsheet programs.

Logged data may be saved in one of three formats. PDF logs may be viewed in a 
PDF reader or in most web browsers. XML and CSV logs may be viewed most 
effectively in a spreadsheet application. 
Each log file is stored in a separate file that is named using the same date-time 
file naming format used for snapshots.
Opening .xml Files in Excel
1. Open the file in Microsoft Excel. 

Note: The file will appear in Microsoft Excel with each field in its 
own column. 

2. Filter the data, since the Extensive Markup Language format is a 
hierarchical format.

a. In the Measurement column, select the drop-down and check only 
the Forward Average label.

b. In the Limit Type column, select the drop-down and check only the 
Lower label.

Note: This will now show data in a time vs. power format. Addi-
tional filtering and sorting can be applied using the options in the 
column headers.

Opening .csv Files in Microsoft Excel
1. Open the file in Microsoft Excel. 

Note: The file will appear in Microsoft Excel with each field in its 
own column. If all the data is in a single column, follow these steps 
to convert it:

a. Click on the column name, to select the entire column.
b. Select Text To Columns, under the Data tab. 

Note: A conversion wizard should open.
c. Select Delimited, under Original Data Type. 
d. Click Next.
e. Check Comma, under Delimiters. 

Note: All other delimiters should be unchecked. Treat Consecu-
tive Delimiters as One should be unchecked. 

f. Click Next.
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g. Click Finish.
2. Create a graph of the forward and reflected average power as a function of 

time: 
a. Select row 1 by clicking on the row name.
b. Select Delete, under the Edit tab. 

Note: The first line of header information will be deleted.
c. Click on cell B1.
d. While holding down the Ctrl key, select columns B (Time), H (Avg 

Fwd W), and J (Avg Rfl W).
e. Select Chart, under the Insert tab. 

Note: The chart wizard should open.
f. Select XY (Scatter). 
g. Select the Line subtype. 
h. Click Next.
i. Click Next in the data range, which should already be set.
j. Enter a title and names for the X and Y axes. 
k. Click Finish.

Note: Other data can be graphed by selecting the appropriate 
columns in step d.
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Zeroing a Sensor

5012, 5016, 5015, 5017, 5018, 5019, 7020, 7022
Over time, the sensor’s “zero value” (reading with no applied RF power) can 
drift, making readings inaccurate. 
For example, if the zero value is –0.02 W, measuring a 50 W signal will give a 
reading of 49.98 W, a 0.04% error. Measuring a 1 W signal will give a reading of 
0.98 W, a 2% error. 

Figure 60   Zeroing Sensor

To zero the sensor:
1. Ensure the sensor has reached a stable operating temperature.
2. Ensure no RF power is applied to the sensor.
3. Do one of the following:

 Click the Measurement menu, then select Zero (may be on the 
Amplitude submenu for some sensors).

 Click the Measurement button, Click Zero in the options control panel.

Note: Calibration will take about 40 seconds. Do not interrupt the 
calibration. A progress bar for the calibration will be displayed on 
the screen.

4. Click Stop/Start to resume data collection.
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Chapter 7 Specifications

Minimum PC Requirements

Software Prerequisites

The VPM3 software requires the installation of the following prerequisites for 
operation.

 Visual C++ 2010 Redistributable or later (provided with VPM3 installer, 
requires approximately 11 MB disk space)

 .NET Framework 4.0 (provided with VPM3 installer)

 VISA Driver (NI-VISA 14.0.1 provided with VPM3 installer, requires 
approximately 65 MB disk space)

If any of these components are NOT installed on the target system, the 
prerequisite installer will install them prior to installing the VPM3 software. If 
any of these components are already installed on the target system the installer 
will skip installing them, and install the VPM3 software.

Operating System

Microsoft Windows Vista with service pack 1
Microsoft Windows 7
Microsoft Internet Explorer
Adobe Acrobat reader

Processor 512 MB RAM & Pentium 4/M or equivalent 

Display 800x600, 256 color display (1280x720, 16 bit or higher 
resolution recommended)

Memory*

Windows Vista
Windows 7

* These values represent the maximum disk space required to install the 
VPM3. Memory requirements for .NET prerequisites will vary 
depending on components that are previously installed.

.Net prerequsites
40.8 MB 
0 MB

VPM3
30 MB
30 MB

TOTAL
70.8 MB
30 MB

Connections 1 available USB port
Drives Hard drive, CD-ROM (for installation)
Accessories Mouse or other pointing device
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